
Kuliah Berseri IlmuKomputer.Com 
Copyright © 2006 IlmuKomputer.Com 
 

Cepat Mahir Adobe Photoshop 8.0 
Chendra Hadi S. 
 

1

CCeeppaatt  MMaahhiirr    
AAddoobbee  PPhhoottoosshhoopp  88..00  
 
 
Chendra Hadi S. 
chendrahadi@yahoo.com 
 

 
 

PPeennddaahhuulluuaann  
Artikel ini adalah modifikasi dari artikel berseri yang berjudul Cepat Mahir Adobe Photoshop 7.0. 
Karena sekian lama tidak sempat melanjutkan artikel tersebut, hingga muncul Adobe Photoshop 8.0, 
maka penulis melakukan modifikasi artikel terdahulu untuk Adobe Photoshop 8.0, dan akan merilis seri-
seri berikutnya (Bab-Bab selanjutnya) yang tertunda sekian lama. 
 
Di dalam artikel ini, akan dibahas mengenai penggunaan software manipulasi image yang sudah cukup 
dikenal, yaitu Adobe Photoshop 8.0. Artikel ini ditujukan kepada para pembaca baik yang belum pernah 
maupun yang sudah biasa menggunakan Adobe Photoshop. Namun penulis mengasumsikan bahwa para 
pembaca telah cukup terbiasa mengoperasikan komputer berbasis Windows. 
 
Materi yang dibahas sebagian besar diambil dari online help Adobe Photoshop, dikelompokkan menjadi 
8 Bab sebagai berikut:  
1. Area Kerja Photoshop (Toolbox)  

Dibahas mengenai user interface Adobe Photoshop secara umum dan fungsi-fungsi tools pada 
toolbox Photoshop. 

2. Area Kerja Photoshop (Lanjutan)  
Dibahas lebih lanjut mengenai area kerja Photoshop, viewing image, penggunaan history palette, 
rulers, guides, measure tool. 

3. Manipulasi Warna  
Dibahas mengenai pengaturan warna image (brightness/contrast, level, saturation, dsb), penggunaan 
eyedropper, color sampler tool, dan tools terkait lainnya. 

4. Selection  
Dibahas mengenai cara melakukan selection image, penggunaan marquee, lasoo tool, dan tools 
terkait lainnya. 

 
Lisensi Dokumen: 
Copyright © 2006 IlmuKomputer.Com 
Seluruh dokumen di IlmuKomputer.Com dapat digunakan, dimodifikasi dan disebarkan 
secara bebas untuk tujuan bukan komersial (nonprofit), dengan syarat tidak menghapus 
atau merubah atribut penulis dan pernyataan copyright yang disertakan dalam setiap 
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5. Menggambar dan Manipulasi Path  
Dibahas mengenai cara penggunaan pen tools dan tools sejenis untuk menggambar dan manipulasi 
path. 

6. Transformation dan Retouching  
Dibahas mengenai pengubahan ukuran image dan canvas, transformasi bentuk image, cloning, 
memperbaiki image, dan penggunaan tools yang terkait. 

7. Layer dan Masking  
Dibahas mengenai penggunaan layer dan masking. 

8. Filter dan Membuat Special Effect 
Dibahas mengenai penggunaan filter dan membuat special effect pada image. 
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BBAABB  II  
AArreeaa  KKeerrjjaa  PPhhoottoosshhoopp  
  
1.1. Pendahuluan 
Berikut adalah tampilan dari Adobe Photoshop 8.0. Apabila tata letak tampilan Photoshop pembaca 
tidak seperti gambar 1.1, silakan coba pilih menu Window > Workspace > Reset Palette Locations. 
 

 
 
 
 
Gambar 1.1 
 
Keterangan: 

A. Toolbox 
B. Tool Option Bar 
C. Menu 
D. Status Bar 
E. Berbagai jenis palette, yang aktif dari atas ke bawah: navigation palette, color palette, history 

palette, dan layer palette 
F. Palette Well (hanya tampak apabila resolusi layar di atas 800 x 600) 

A B C D E F 
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1.1.A. Toolbox 
Toolbox berisi berbagai macam tools yang digunakan untuk melakukan manipulasi image. Penjelasan 
singkat fungsi masing-masing tool pada Toolbox akan dibahas pada Bab 1.2. 
 
1.1.B. Tool Option Bar 
Hampir semua tool pada Toolbox memiliki options yang ditampilkan pada Tool Option Bar. Options 
tersebut digunakan untuk mengatur nilai parameter dari tool yang sedang aktif/dipilih. Gambar 1.2 
adalah contoh tampilan tool option bar jika tool Magic Wand        pada toolbox (shortcut keyboard: W) 
diaktifkan: 

 
Gambar 1.2 
 
Setelah nilai parameter pada tool option bar diubah-ubah (misalnya nilai Tolerance), kita dapat 
mengembalikannya lagi menjadi nilai default (nilai semula). Yaitu dengan klik icon yang ada di 
bagian paling kiri tool option bar, kemudian klik tombol . Pada context menu yang muncul, pilih 
Reset Tool untuk mengembalikan nilai default dari tool yang sedang dipilih. Apabila ingin 
mengembalikan nilai default semua tools di toolbox, pilih Reset All Tools. Untuk jelasnya bisa dilihat 
pada gambar 1.3. 

 
Gambar 1.3 
 
 
 
Apabila ingin menyembunyikan/menampilkan Tool Option Bar, Pilih Menu Window, kemudian klik 
pada item menu Options untuk menghilangkan atau mengaktifkan tanda checknya. (Gambar 1.4) 
 
1.1.C. Menu 
Berikut adalah menu-menu yang terdapat pada Adobe Photoshop 8.0: 

1. File  
Berkaitan dengan file seperti menyimpan, membuka, export, import, dan cetak. 

2. Edit  
Berkaitan dengan editing secara umum seperti cut, copy, paste, transform image, serta untuk 
mengatur preferences Adobe Photoshop.  

3. Image  
Berisi editing image untuk mengatur warna, hue/saturation, brightness/contrast, ukuran, dsb. 

Gambar 1.4 
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4. Layer  
Berkaitan dengan manajemen layer pada image, seperti menambah layer, menghapus, 
menambah efek pada layer, serta masking.  

5. Select  
Berkaitan dengan selection image.  

6. Filter  
Berisikan filter-filter yang terinstall pada Photoshop yang dapat digunakan untuk memberi efek 
tertentu pada image.  

7. View  
Digunakan untuk pengaturan view seperti zooming image, menampilkan skala, dan sebagainya.  

8. Window  
Digunakan untuk pengaturan window 

9. Help  
Digunakan untuk menampilkan help Adobe Photoshop. 

 
1.1.D. Status Bar 
Status bar berisikan keterangan mengenai tool di toolbox yang sedang aktif, serta keterangan image yang 
sedang aktif. Status bar pada Photoshop dapat ditampilkan/disembunyikan dengan memilih menu 
Window > Status Bar. 
Untuk lebih memahami kegunaan status bar, bisa praktekkan sbb: 
1. Buat dokumen baru, dengan memilih menu File > New... (shorcut keyboard: Ctrl+N). Akan keluar 
dialog seperti gambar 1.5, isikan nilai2nya seperti pada gambar 1.5, agar tampilannya mirip dengan yang 
ada di artikel ini (gambar 1.6). Klik tombol Ok. 

 
Gambar 1.5 
 
2. Tahan tombol Alt, kemudian klik kiri pada status bar (gambar 1.6.C), akan terlihat keterangan 
dokumen image yang sedang aktif.  
3. Apabila kita perhatikan gambar 1.6.B, Paint Bucket Tool kebetulan sedang aktif, dan pada status bar 
nya terdapat juga keterangan dari tool tersebut. Untuk jelasnya silakan baca pada keterangan gambar 
yang ada di bawah gambar 1.6. 
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Gambar 1.6 
 
Keterangan: 
A. Skala tampilan pada kanvas (view area image) (gambar 1.6.G), pada gambar menunjukkan skala 
tampilan adalah 100% 
B. Paint Bucket Tool pada toolbox sedang aktif 
C. Informasi/Keterangan tentang dokumen yang sedang aktif di kanvas (view area image). 
D. Informasi/Keterangan tentang dokumen yang sedang aktif di kanvas (view area image). Untuk 
menampilkan, tekan Alt+Klik atau Ctrl+Klik pada (gambar 1.6.C) . 
E. Digunakan untuk mengubah informasi/keterangan pada (gambar 1.6.C) 
F. Penjelasan singkat mengenai tool yang sedang aktif (pada contoh ini Paint Bucket Tool) 
G. View area image atau kanvas, merupakan area dokumen image yang sedang kita edit. 
 
 
 
 

B FA C D E G 
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1.1.E. Palette 
Palette Photoshop berguna untuk memudahkan dalam navigasi maupun editing image. Untuk 
menyembunyikan/menampilkan palette, digunakan menu Window, kemudian pilih palette yang ingin 
disembunyikan/ditampilkan. 
 
 
1.1.F. Palette Well 
Palette well digunakan untuk memudahkan dalam pengaturan palette. Namun palette well hanya tersedia 
jika resolusi layar lebih besar dari 800 x 600 (resolusi minimal yang disarankan adalah 1024 x 768). 
Apabila suatu palette diletakkan di palette well, maka palette akan bersifat tersembunyi. Ketika title dari 
palette diklik, barulah palette akan ditampilkan. Jika area di luar palette di klik, maka palette tersebut 
akan tersembunyi kembali.  
Untuk menyimpan palette ke dalam palette well, seret (drag) tab palette ke dalam palette well hingga 
palette well ter-highlight.(Gambar 1.7, memperlihatkan palette tab navigator di-drag ke palette well) 

 
Gambar 1.7 
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1.2. Toolbox 
Berikut ini akan dijelaskan mengenai fungsi dari masing-masing tools yang terdapat pada toolbox Adobe 
Photoshop 8.0. Untuk cara penggunaan lebih detil masing-masing tools akan dijelaskan secara terpisah 
pada Bab-bab selanjutnya. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Gambar 1.8 
 
 
1.2.A. Marquee Tool 
Terdiri dari 4 jenis, yaitu: 

1. Rectangular Marquee (Shortcut keyboard: M, atau Shift + M)  
  Digunakan untuk membuat area selection berbentuk segi empat.pada image. 
 
2. Elliptical Marquee (Shortcut keyboard: M, atau Shift + M) 
  Digunakan untuk membuat area selection berbentuk elips atau lingkaran pada image. 
 
3. Single Row Marquee 
  Digunakan untuk membuat area selection satu baris pada image (ukuran tinggi selection 

adalah 1 pixel)  
 
4. Single Column Marquee 
  Digunakan untuk membuat area selection satu kolom pada image (ukuran lebar selection 

adalah 1 pixel). 
 
 
1.2.B. Move Tool 

Shortcut keyboard: V 
Digunakan untuk menggeser/memindah selection, layers, dan guides. 

 
 

A 
C 
E 

G 
I 
K 
M 
O 
Q 

S 
U 

B 
D 
F 

H 
J 
L 
N 
P 
R 
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V 

Keterangan: 
A. Marquee tool 
B. Move tool 
C. Lasso tool 
D. Magic Wand tool 
E. Crop tool 
F. Slice tool 
G. Patch tool 
H. Brush tool 
I. Stamp tool 
J. History Brush tool 
K. Eraser tool 
L. Paint Bucket tool 
M. Sharpen tool 
N. Burn tool 
O. Path Selection tool 
P. Type tool 
Q. Pen tool 
R. Custom Shape tool 

S. Notes tool 
T. Eyedropper tool 
U. Hand tool 
V. Zoom tool 
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1.2.C. Lasoo Tool (Shortcut keyboard: L, atau Shift + L untuk mengubah jenis Lasoo) 
Terdiri dari 3 jenis, yaitu: 

1. Lasoo 
Digunakan untuk membuat area selection dengan bentuk bebas 
 

2. Polygonal Lasoo 
Digunakan untuk membuat area selection berbentuk poligon 
 

3. Magnetic Lasoo 
Digunakan untuk membuat area selection dengan cara menempelkan tepi selection pada 
area tertentu pada image. 

 
 
1.2.D. Magic Wand Tool 

Shortcut keyboard: W  
Digunakan untuk membuat area selection yang memiliki warna serupa. Perbedaan toleransi 
warna dapat diatur pada tool option bar. 

 
 
1.2.E. Crop Tool 

Shortcut keyboard: C  
Digunakan untuk memangkas image (memotong dan membuang area tertentu dari image) 

 
 
1.2.F. Slice Tool (Shortcut keyboard: K, atau Shift + K untuk mengubah jenis slice) 
Terdiri dari 2 jenis: 

1. Slice Tool 
Digunakan untuk membuat potongan-potongan image dari suatu image 
 

2. Slice Select Tool 
Digunakan untuk memilih potongan pada suatu image 

 
 
1.2.G. Healing Brush, Patch, Color Replacement Tool (Shortcut keyboard: J, atau Shift + J 
mengubah tool) 

1. Patch Tool  
Digunakan untuk mengecat/melukis pada area tertentu image dengan pola (pattern) atau 
sample tertentu. Cocok untuk memberbaiki image yang rusak. 

 
2. Healing Brush Tool  

Digunakan untuk mengecat/melukis image dengan pola atau sample tertentu. Cocok 
untuk memperbaiki image yang agak rusak. 

 
3. Color Replacement Tool  

Digunakan untuk mengecat/mewarnai image dengan pola warna tertentu. 
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1.2.H. Brush, Pencil Tool (Shortcut keyboard: B, atau Shift + B untuk mengubah tool) 
1. Brush Tool 

Digunakan untuk melukis image dengan goresan kuas 
 

2. Pencil Tool 
Digunakan untuk melukis image dengan goresan pencil 

 
 
1.2.I. Stamp Tool (Shortcut keyboard: S, atau Shift + S untuk mengubah jenis stamp) 
Terdiri dari 2 jenis, yaitu:  

1. Clone Stamp Tool 
Digunakan untuk melukis image dengan sample image tertentu 
 

2. Pattern Stamp Tool 
Digunakan untuk melukis image dengan menggunakan pola tertentu 

 
 
1.2.J. History Brush Tool (Shortcut keyboard: Y, atau Shift + Y untuk mengubah jenis) 
Terdiri dari 2 jenis, yaitu: 

1. History Brush Tool  
Digunakan untuk melukis image menggunakan snapshot atau state history dari image 2.  
 

2. Art History Tool  
Digunakan untuk melukis image menggunakan snapshot atau state history dari image, 
dengan model artistik tertentu. 

 
 
1.2.K. Eraser Tool (Shortcut keyboard: E, atau Shift + E untuk mengubah jenis eraser) 
Terdiri dari 3 jenis, yaitu: 

1. Eraser  
Digunakan untuk menghapus pixel image dan mengembalikannya ke state tertentu. 
 

2. Background Eraser  
Digunakan untuk menghapus area tertentu image menjadi transparan. 
 

3. Magic Eraser  
Digunakan untuk menghapus area tertentu image yang memiliki warna yang serupa 
menjadi transparan dengan satu kali klik. 

   
 
1.2.L. Paint Bucket, Gradient Tool (Shortcut keyboard: G, atau Shift + G) 

1. Paint Bucket Tool  
Digunakan untuk mengecat area yang dipilih dengan warna foreground atau pola 
tertentu. 
 

2. Gradient Tool  
Digunakan untuk mengecat area yang dipilih (selected area) dengan perpaduan 
banyak warna. 
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1.2.M. Blur, Sharpen, Sharpen Tool (Shortcut keyboard: R, atau Shift + R) 
1. Blur Tool 

Digunakan untuk menghaluskan/mengaburkan area tertentu pada image. 
 

2. Sharpen Tool 
Digunakan untuk menajamkan area tertentu pada image. 
 

3. Smudge Tool 
Digunakan untuk menggosok/mencoreng area tertentu pada image 

 
 
1.2.N. Dodge, Burn, Sponge Tool (Shortcut keyboard: O, atau Shift + O) 

1. Dodge Tool 
Digunakan untuk menerangkan warna di area tertentu pada image 
 

2. Burn Tool 
Digunakan untuk menggelapkan warna di area tertentu pada image 
 

3. Sponge Tool 
Digunakan untuk mengubah saturation di area tertentu pada image 

 
 
1.2.O. Path Selection Tool (Shortcut keyboard: A, atau Shift + A untuk mengubah jenis) 
Terdiri dari 2 jenis, yaitu: 

1. Path Selection Tool 
Digunakan untuk melakukan selection path 

 
2. Direct Selection Tool 

Digunakan untuk mengubah anchor dan direction point dari path. (Path akan 
dibahas lebih lanjut pada Bab 5) 

 
 
1.2.P. Type tool (Shortcut keyboard: T, atau Shift + T untuk mengubah jenis) 
Terdiri dari 4 jenis, yaitu: 

1. Horizontal Type Tool 
Digunakan untuk membuat tulisan secara horizontal 
 

2. Vertical Type Tool 
Digunakan untuk membuat tulisan secara vertikal 
 

3. Horizontal Type Mask Tool 
Digunakan untuk membuat selection berbentuk tulisan secara horizontal 
 

4. Vertical Type Mask Tool 
Digunakan untuk membuat selection berbentuk tulisan secara vertikal 

 
 
 
 
 



Kuliah Berseri IlmuKomputer.Com 
Copyright © 2006 IlmuKomputer.Com 
 

Cepat Mahir Adobe Photoshop 8.0 
Chendra Hadi S. 
 

12

1.2.Q. Pen Tool 
1. Pen Tool (Shortcut keyboard: P, atau Shift + P) 

Digunakan untuk membuat path dengan lengkung-lengkung yang halus 
 
2. Freeform Pen Tool (Shortcut keyboard: P, atau Shift + P)  

Digunakan untuk membuat path berbentuk bebas 
 
3. Add Anchor Point Tool 

Digunakan untuk menambah anchor point pada path 
 
4. Delete Anchor Point Tool  

Digunakan untuk menghapus anchor point tertentu pada path  
 
5. Convert Point Tool  

Digunakan untuk mengubah anchor dan direction point tertentu pada path    
 
 
1.2.R. Shape Tool (Shortcut keyboard: U, atau Shift + U untuk mengubah jenis) 

1. Rectangle Tool 
Digunakan untuk menggambar bentuk segi empat 

 
2. Rounded Rectangle Tool 

Digunakan untuk menggambar segi empat melengkung 
 
3. Ellipse Tool 

Digunakan untuk menggambar ellipse 
 
4. Polygon Tool 

Digunakan untuk menggambar polygon 
 
5. Line Tool 

Digunakan untuk menggambar garis lurus 
 
6. Custom Shape Tool  

Digunakan untuk menggambar bentuk tertentu dari daftar bentuk yang dapat dipilih 
pada option bar 

 
      
1.2.S.  Notes Tool (Shortcut keyboard: N, atau Shift + N untuk mengubah jenis) 

1. Notes Tool 
Digunakan untuk membuat catatan pada image 

 
2. Audio AnnotationTool 

Digunakan untuk membuat suara/audio pada image 
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1.2.T. Eyedropper, Measure Tool (Shortcut keyboard: I, atau Shift + I untuk mengubah jenis) 
1. Eyedropper Tool  

Digunakan untuk mengambil sample warna pada image untuk warna foreground  
 
2. Color Sampler Tool 

Digunakan untuk mengambil berbagai sample warna pada image 
 

3. Measure Tool 
Digunakan untuk mengukur jarak atau sudut pada image 

 
 
 
 
1.2.U. Hand Tool 

Shortcut keyboard: H  
Digunakan untuk menggeser/memindah bidang pandang image di dalam kanvas. 
 

 
 
1.2.V. Zoom Tool 

Shortcut keyboard: Z  
Digunakan untuk memperbesar atau memperkecil tampilan image. 

 


